Stop Jerky Graphics
If you are connected to a LAN and have problems with jerky graphics, this might be the
solution:
•
•
•
•
•
•
•

Right-click "My Computer".
Select "Manage".
Click on "Device Manager".
Double-click on your NIC under "Network Adapters".
In the new window, select the "Advanced" tab.
Select "Connection Type" and manually set the value of your NIC. (Not "Auto
Sense" which is default.).
You should reboot.

Shutdown XP Faster
Like previous versions of windows, it takes long time to restart or shutdown windows XP
when the "Exit Windows" sound is enabled. To solve this problem you must disable this
useless sound.
•
•
•

Click Start button.
Go to settings > Control Panel > Sound, Speech and Audio devices > Sounds and
Audio Devices > Sounds.
Then under program events and windows menu click on "Exit Windows" sub-menu
and highlight it. Now from sounds you can select, choose "none" and then click
Apply and OK.

Now you should see some improvements when shutting down your system.

Speeding Up Your Pentium 2 by 50%
We all know that you really shouldn't try to run Windows XP on anything less that about a
Pentium 3 of some sort if you are out for speedy operations and amazing reaction times,
but for those of us with the good old Pentium 2's who want to see just how well we can run
XP, we have to tweak as much as we can where-ever we can. A real killer to the system's
performance is Windows Media Player. Although it may look desirable and fancy with it's
rounded off edges and 3rd-Dimensional appearance, the truth is, it takes up a large
amount of that precious processing power. All of these troubles however, lead to one
thing in particular with this 'new-look' over-rated music and video player...the
Visualizations. The look-great I'll admit but like a lot of software these days, it has no
purpose. If you run the task manager, and click the Performance tab along the top, you'll
see that when Windows Media Player is running and nothing else is active, it takes up
around 50% of the processors power. Once these visualizations are turned off, it barely
takes up 2-3% of the processors power, which leaves much more room for other
applications to work efficiently.
Here's how to disable the feature:
•
•
•

Open Media Player.
Make sure the Now Playing tab on the left is selected.
Click the View menu along the top.

•
•

Go down to Now Playing Tools.
In the sub-menu that has just 'popped-out', uncheck Show Visualization.

Speed Up Detailed View in Explorer
If you like to view your files in Windows Explorer using the "Details" view here is a tweak
to speed up the listing of file attributes:
Viewing files in Windows Explorer using the "Details" mode shows various attributes
associated with each file shown. Some of these must be retrieved from the individual files
when you click on the directory for viewing. For a directory with numerous and relatively
large files (such as a folder in which one stores media, eg: *.mp3's, *.avi's etc.), Windows
Explorer lags as it reads through each one. Here's how to disable viewing of unwanted
attributes and speed up file browsing:
•
•
•
•

Open Windows Explorer.
Navigate to the folder which you wish to optimize.
In "Details" mode right-click the bar at the top which displays the names of the
attribute columns.
Uncheck any that are unwanted/unneeded.

Explorer will apply your preferences immediately, and longs lists of unnecessary
attributes will not be displayed.
Likewise, one may choose to display any information which is regarded as needed, getting
more out of Explorer.

Easily Disable Messenger
Go into: C:/Program Files/Messenger. Rename the Messenger folder to "MessengerOFF".
This does not slow down Outlook Express or hinder system performance.

Turn Off System Restore to Save Space
By default, Windows XP keeps a backup of system files in the System Volume Information
folder. This can eat up valuable space on your hard drive. If you don't want Windows to
back up your system files:
•
•
•
•
•
•

Open the Control Panel.
Double-click on System.
Click the System Restore tab.
Check "Turn off System Restore on all drives".
Hit Apply.
You may now delete the System Volume Information folder.

Warning! If you turn this off you will not be able to use Windows System Restore to
restore your system in case of failure.

Very Slow Boot When Networking
On some XP Pro installations, when connected to a network (peer-peer in this case), the
computer boot time is over 1:40. The system seems to freeze after logging in and the

desktop may not appear or will freeze for a minute. As timed with the utility, Bootvis.exe,
the problem was with the driver mrxsmb.dll, adding over 67 seconds to the boot time.
Turning off and restoring file and printer sharing eliminated 65 seconds from the boot
time.
•
•
•
•
•

Alt-click (or right-click) on Network Places > Properties.
Alt-click on Ethernet Adapter connection > Properties.
Un-check "File and Printer Sharing for Microsoft Networks" > OK.
Reboot.
If you need file or printer sharing, repeat the above, re-check the box and re-boot
again.

Easy Way to Adjust LargeSystemCache
Normally, the tweak I've seen asks you to go into
HKLM\System\CurrentControlSet\Control\Session Manager\Memory Management and
change the value to either O or 1 to the adjustment the LargeSystemCache.
However, in Windows XP, all you have to do is:
•
•
•
•
•
•
•

•

Right-click My Computer.
Select Properties.
Click Advanced.
Choose Performance.
Click Advanced again.
Select either Programs or System Cache under Memory Usage.
Programs = 0 for the registry tweak equivalent
System Cache = 1 for the registry tweak equivalent
On NT Server (in this case XP), the Large System Cache option is enabled, but
disabled on Workstation. The two different settings effect how the cache manager
allocates free memory. If the Large Cache option is on, the manager marks all the
free memory, which isn't being used by the system and/or applications, as freely
available for disk caching.
On the flip-side (with a small cache), the manager instead only sets aside 4MB of
memory for disk caching in an attempt to accelerate the launch of applications. Or
in a more technical approach, if enabled the system will favor system-cache
working sets over process working sets (with a working set basically being the
memory used by components of a process).

Slow Start-up When Using Norton Internet
Security 2002
If you are using Norton Internet Security 2002, and are experiencing slow start-up of XP,
(i.e. you can see the desktop with icons etc. but it takes 30-60sec before you can start
using the computer), this fix might help:
•
•
•
•

Click on Start button.
Select Control Panel.
Open "Network Connections".
Under "LAN and High-Speed Internet", right-click on your "Local Area Connection"
and select "Properties".

•
•
•
•
•

Under "General" tab, select "Internet Protocol (TCP/IP)" and select "Properties".
Select "Use the following IP address:".
Under "IP address" enter following : 192.168.0.1
Under "Subnet Mask:" enter following : 255.255.255.0
Click "Ok".

Correcting System Hang at Startup
If your system hangs about 2 or 3 minutes at startup, where you can't access the Start
button or the Taskbar, it may be due to one specific service (Background Intelligent
Transfer) running in the background. Microsoft put out a patch for this but it didn't work
for me. Here's what you do:
•
•
•

Click on Start/Run, type 'msconfig', then click 'OK'.
Go to the 'Services' tab, find the 'Background Intelligent Transfer' service.
Disable it, apply the changes & reboot.

Disable XP Boot Logo
It is possible to disable the XP splash screen, which will slightly speed up the overall boot
process. Be aware that removing the splash screen will also cause you not to see any
boot-up messages that might come up (chkdsk, convert ... ), but if your system runs
without any problems then it should not matter.
•
•

Edit boot.ini.
Add " /noguiboot" right after "/fastdetect".

Upon restarting, the splash screen will be gone. It can be re-enabled by removing the new
switch.

Slow Network Access Not Always Due to
Scheduled Tasks Check
If you have very slow access to your network computers through "My Network Places"
and have already deleted the Registry entry calling for a check of Scheduled Tasks on the
other network computers (documented elsewhere on this site) AND you have multiple
network adaptors (i.e. a cable or DSL connection through one NIC and an internal network
using a second NIC) check the following:
•
•
•
•
•
•
•

Right-click on "My Network Places", go to Properties.
Right-click on the NIC that your cable/DSL connects to, and choose Properties.
Select Internet Protocol (TCP/IP), and click on Properties.
Click on "Advanced", go to "WINS" tab, and chose Disable NetBios over TCP/IP.
When you are back at your Network Connections page, right-click on the
Broadband selection.
Choose "Properties", click on the Networking tab.
Again, choose TCP/IP, Properties, Advanced, WINS, and select "disable NetBios
over TCP/IP".

Turn Off Indexing to Speed Up XP
Windows XP keeps a record of all files on the hard disk so when you do a search on the
hard drive it is faster. There is a downside to this and because the computer has to index
all files, it will slow down normal file commands like open, close, etc. If you do not do a
whole lot of searches on your hard drive then you may want to turn this feature off:
•
•
•
•

Open My Computer.
Right-click your hard drive icon and select Properties.
At the bottom of the window you'll see "Allow indexing service to index this disk
for faster searches," uncheck this and click ok.
A new window will pop up and select Apply to all folders and subfolders.

It will take a minute or two for the changes to take affect but then you should enjoy slightly
faster performance.

Clean Your Prefetch to Improve Performance
This is a unique technique for WinXP. We know that it is necessary to scrub registry and
TEMP files for Win9X/ME/2000 periodically. Prefetch is a new and very useful technique in
Windows XP. However, after using XP some time, the prefetch directory can get full of junk
and obsolete links in the Prefetch catalog, which can slow down your computer
noticeably.
•

Open C(system drive):/windows/prefetch, delete those junk and obsolete files,
reboot. It is recommended that you do this every month.

Remove Hibernation File
If you do not use hibernation, make sure you do not have it enabled, which reserves disk
space equal to your RAM. If you have a hidden file on the root directory of your C-drive
called hiberfil.sys, hibernation is enabled. To remove that file:
•

Go to Control Panel, select Performance and Maintenance, Power Options,
Hibernate tab, and uncheck the Enable hibernation box.

Performance Increase Through My Computer
Easy enough tweak to usually find out about it on your own, but still, some of us still don't
find it right away. So here it is:
•
•
•
•

Start > right-click on My Computer and select Properties.
Click on the "Advanced" tab.
See the "Performance" section? Click "Settings".
Disable the following:
Fade or slide menus into view
Fade or slide ToolTips into view
Fade out menu items after clicking
Show Shadows under menus

Slide open combo boxes
Slide taskbar buttons
Use a background image for each folder type
Use common tasks in folders
There, now Windows will still look nice and perform faster.

Reduce 10 Second Scandisk Wait Time
•

Start MS Dos Prompt (Start run CMD), and type: CHKNTFS /T:4
where 4 is the amount of wait time.
CHKNTFS /?
for more info.

DMA Mode on IDE Devices
Just like Windows 2000, Windows XP still fails to set the DMA mode correctly for the IDE
device designated as the slaves on the primary IDE and secondary IDE channels. Most CDROMS are capable of supporting DMA mode, but the default in XP is still PIO. Setting it to
DMA won't make your CD-ROM faster, but it will consume less CPU cycles. Here's how:
•
•
•
•
•

Open the Device Manager. One way to do that is to right-click on "My Computer",
select the Hardware tab, and select Device Manager.
Expand "IDE ATA/ATAPI Controllers" and double-click on "Primary IDE Channel".
Under the "Advanced Settings" tab, check the "Device 1" setting. More than likely,
your current transfer mode is set to PIO.
Set it to "DMA if available".
Repeat the step for the "Secondary IDE Channel" if you have devices attached to it.
Reboot.

Load Internet Explorer the Fastest Way Possible
•

Edit your link to start Internet Explorer to have -nohome after it. For Example:
"C:\Program Files\Internet Explorer\IEXPLORE.EXE" -nohome

This will load internet explorer very fast because it does not load a web page while it is
loading. If you want to go to your homepage after it is loaded, just click on the home
button.

Remove Messenger
•

Go to Start/Run, and type: "rundll32 setupapi,InstallHinfSection BLC.Remove 128
%SystemRoot%\INF\msmsgs.inf"

Auto Login
•
•

Go to Start/Run, and type 'control userpasswords2'.
From Users Tab, Uncheck "Users must enter ...."

•

A dialog will allow setting a user and password to be used automatically.

Turn Off Autoplay for Program CDs
How can you stop Windows XP from launching program CDs?
•
•
•
•

Click Start, click Run, type GPEDIT.MSC to open Group Policy in the Microsoft
Management Console.
Double-click Computer Configuration, double-click Administrative templates,
double-click System, and then click Turn off autoplay.
The instructions on your screen describe how to configure this setting. Click
Properties to display the setting dialog.
Click Enabled, and choose CD-ROM drives, then click OK, to stop CD autoplay.

This setting does not prevent Autoplay for music CDs.

Change Drive Letters in Windows XP
When you add drives to your computer, such as an extra hard drive, a CD drive, or a
storage device that corresponds to a drive, Windows automatically assigns letters to the
drives. However, this assignment might not suit your system; for example, you might have
mapped a network drive to the same letter that Windows assigns to a new drive. When you
want to change drive letters, follow these steps:
•
•
•
•

Right-click My Computer, and then click Manage.
Under Computer Management, click Disk Management. In the right pane, you’ll see
your drives listed. CD-ROM drives are listed at the bottom of the pane.
Right-click the drive or device you want to change, and then click Change Drive
Letter and Paths.
Click Change, click Assign the following drive letter, click the drive letter you want
to assign, and then click OK.

Synchronize Your Computer Clock with an
Internet Time Server
Does your computer have the right time? If your computer is not part of a domain, you can
synchronize your computer clock with an Internet time server. To do so:
•
•
•

Double–click the time on your task bar.
Click the Internet Time tab.
Select the time server you want to use and make sure to select the Automatically
synchronize with an Internet time
server check box.

Do Not Highlight Newly Installed Programs
Tired of that annoying little window that pops up to tell you that new software is installed?
If it gets in the way when you’re logging off, turn it off completely. To do this:

•
•
•
•

Click Start, right-click at the top of the Start menu where your name is displayed,
and then click Properties.
In the Taskbar and Start Menu Properties dialog box, on the Start Menu tab, click
Customize.
Click the Advanced tab, and then clear the Highlight newly installed programs
check box.
Click OK, and then click OK again.

Change the Default Opening Folder in Windows
Explorer
By default, Windows Explorer opens showing the My Documents folder. To change the
default setting so that all top–level drives and folders are shown, follow these steps:
•
•

Click Start > Programs > Accessories, then right–click Windows Explorer, and click
Properties.
Under Target field, which reads %SystemRoot%\explorer.exe, add to make the line
read:

•

%SystemRoot%\explorer.exe /n, /e, /select, C:\
Click OK.

You Can Bypass the Recycle Bin On the Fly.
To bypass the Recycle Bin on a one-time basis, when you are deleting a file (or a group of
selected files):
•

Press and hold down the shift-key while you press the del-key (or use the delete
command). You receive the following confirmation-request message:
Are you sure you want to send <filename> to the Recycle Bin?

Identify a 16-bit Program
•
•
•

Use Windows Explorer to open the folder that contains the program's executable
(.exe) file.
Right-click the .exe file, and then click Properties.
A 16-bit program does not have a Version tab in this dialog box.

Use the Desktop Cleanup Wizard in Windows XP
To start the Desktop Cleanup Wizard:
•
•
•
•

Click Start , and then click Control Panel.
In Control Panel, click Appearance and Themes under Pick a category.
Under or pick a Control Panel icon , click Display. The Display Properties dialog
box is displayed.
In the Display Properties dialog box, click the Desktop tab, and then click
Customize Desktop. The Desktop Items dialog box is displayed.

•
•

Under Desktop cleanup , click to clear the Run Desktop Cleanup Wizard every 60
days check box if you do not want the Desktop Cleanup Wizard to automatically
start every 60 days.
Click Clean Desktop Now. The Desktop Cleanup Wizard starts.

Remove Unwanted Shortcuts
•
•
•
•

In the Welcome to the Desktop Cleanup Wizard dialog box, click Next.
In the Shortcuts dialog box, a list of shortcuts are displayed in the Shortcut to
Clean Up list. The shortcuts that you click are removed from the desktop and
placed in the Unused Desktop Shortcuts folder on the Windows desktop.
If you do not want a shortcut to be removed from the desktop, click to clear the
check box for that shortcut, and then click Next when you are finished.
In the Completing the Desktop Cleanup Wizard dialog box, view the items in the
Shortcuts box to confirm that you want them removed from the desktop, and then
click Finish.

The Desktop Cleanup Wizard moves the selected shortcuts to the Unused Desktop
Shortcuts folder and then quits.

Restore Shortcuts
If a shortcut that you want is removed, follow these steps to restore the shortcut:
•

•
•

On the Desktop, double-click the Unused Desktop Shortcuts folder. The Unused
Desktop Shortcuts dialog box is displayed. Note: If the Unused Desktop Shortcuts
dialog box is maximized, click the Restore Down button (appears to the left of the
red Close button).
Drag the shortcut that you want to the Windows desktop.
Close the Unused Desktop Shortcuts dialog box.

How to Turn On Automatic Updates
•
•

Click Start , click Control Panel , and then double-click System.
Click the Automatic Updates tab, and then click one of the following options:
- Download the updates automatically and notify me when they are ready to be
installed. (This is the default setting.)
- Notify me before downloading any updates and notify me again before installing
them on my computer.

How to Turn Off Automatic Updates
•
•

Click Start , click Control Panel , and then double-click System.
Click the Automatic Updates tab, and then click Turn off automatic updating. I want
to update my computer manually.

How to Update Your Files Manually by Using
Windows Update
If you choose not to use automatic updating, you can still install specific updates from the
Windows Update Web site. Windows Update is a catalog of items such as drivers, security
fixes, critical updates, the latest Help files, and Internet products that you can download to
keep your computer up-to-date.
•
•
•

Click Windows Update in Help and Support Center.
On the Windows Update home page, click Scan for updates.
Click Yes when you are prompted to install any required software or device
drivers.

How to Have Windows Remind You About
Pending Updates
•
•
•
•

Click Remind Me Later in the Automatic Updates dialog box before you download
or install the update.
In the Reminder dialog box, you can specify the amount of time Windows should
wait before reminding you.
If the reminder is for downloading, Windows reminds you only when you are
connected to the Internet.
If the reminder is for installing, Windows reminds you according to the schedule
that you specify.

How to Download Available Updates
If you configured automatic updating to notify you before downloading any updates, an
icon is displayed in the notification area each time new updates are found.
•
•

Double-click the icon in the notification area.
Do either of the following steps:
If you want Windows to download an update, make sure that the check box beside
it is selected.
-orIf you do not want Windows to download an update, click to clear the check box
beside it.

Your selected updates are downloaded in the background; this behavior allows you to
continue working uninterrupted. Downloading does not interfere with or slow down other
network activity, such as Internet browsing.
When downloading is finished, the icon is displayed in the notification area to notify you
that updates are ready to be installed.

How to Pause or Resume Downloading
After the download process has started, you can pause or resume downloading at any

time. If you close your Internet connection or restart your computer after pausing a
download process, Windows automatically resumes the download process the next time
you are connected to the Internet.
•
•

During the download process, click the icon that is displayed in the notification
area, and then click Pause.
When you are ready for Windows to start downloading again, click the Automatic
updating icon, and then click
Resume.

Restore an Update that You Previously Declined
If you decide not to download a specific update, you can prompt Windows Update to offer
that update again.
•
•

Click Start , click Control Panel, and then double-click System.
Click the Automatic Updates tab, and then click Restore Declined Updates.

Change Out Your Pointer Scheme
Tired of seeing your pointer as an arrow or an hourglass all the time? Windows XP offers a
number of alternative pointer schemes, such as Dinosaur, Ocean and Sports:
•
•
•

Open the Control Panel, double-click Mouse, and select the Pointers tab. (If you
start in Category view, select Appearance and Themes, then click Mouse Pointers
under "See Also").
Next to Schemes, click the down arrow and select a scheme to preview its
pointers.
Click OK to apply the scheme to your desktop.

Use the Ultimate Configuration Tool (Professional
Edition Only)
One of the most full featured Windows XP configuration tools available is hidden right
there in your system, but most people don't even know it exists. It's called the Local Group
Policy Editor, or gpedit for short.
To invoke this editor:
•

Select Start and then Run, then type the following:
gpedit.msc

After you hit Enter, you'll be greeted by gpedit, which lets you modify virtually every
feature in Windows XP without having to resort to regedit.

Customize the Start menu
The Start menu gets more real estate in XP than in previous versions, and it's more

customizable. To make the Start menu display only the applications you want, rather than
the default determined by Microsoft:
•
•

Right-click in an empty section of the Start menu's left column.
Select Properties > Start Menu > Customize. Here you'll find a list of your most
frequently used programs. (XP keeps track of what you use and what you don't,
then updates this list dynamically).

Don't want your boss to know that Pinball, Solitaire, and Quake all make your list?
•

Go to the General tab, click Clear List, and set the counter to zero.

Internet Connection Sharing
To enable Internet Connection Sharing on a network connection:
•
•
•
•
•

•

Open Network Connections.
Click the dial-up, local area network, PPPoE, or VPN connection you want to share.
Then, under Network Tasks, click Change settings of this connection.
On the Advanced tab, select the Allow other network users to connect through this
computer's Internet connection
check box.
If you want this connection to dial automatically when another computer on your
home or small office network
attempts to access external resources, select the Establish a dial-up connection
whenever a computer on my network
attempts to access the Internet check box.
If you want other network users to enable or disable the shared Internet
connection, select the Allow other network
users to control or disable the shared Internet connection check box. Under
Internet Connection Sharing, in Home networking connection, select any adapter
that connects the computer sharing its Internet connection to the other computers
on your network.

Win XP Won’t Completely Shutdown
•
•
•

Go to Control Panel, then go to Power Options.
Click on the APM tab, then check the "Enable Advanced Power Management
support."
Shut down your PC.

It should now successfully complete the Shut Down process.

Adjust Various Visual Effects
•
•
•

Open up the Control Panel.
Go under System and click on the Advanced tab.
Click settings under Performance options.

You can now change various graphical effects (mainly animations and shadows).

Disable Error Reporting
•
•
•
•
•
•
•

Open Control Panel.
Click on Performance and Maintenance.
Click on System.
Then click on the Advanced tab.
Click on the error-reporting button on the bottom of the windows.
Select Disable error reporting.
Click OK. Click OK.

Close Multiple Windows
If you just opened a number of separate, related windows (a folder inside a folder, and so
on), there's an easier way to close them all than one-at-a-time:
•

Hold down the shift-key as you click the X caption button in the upper-right corner
of the last window opened. Doing so closes that window and all windows that
came before it.

Enable Clear Type
Easy way: Click on or cut and paste link below:
http://www.microsoft.com/typography/cleartype/cleartypeactivate.htm?fname=%20&fsize=
or
•
•
•
•

Right-click on a blank area of the Desktop and choose Properties.
Click on the Appearance tab; click effects.
Check the box: Use the following method to smooth edges of screen fonts.
In the drop down box select: Clear Type.

Turn Off CD Auto Play
•
•
•
•
•
•
•
•

Open My Computer.
Right-click on your CD-ROM and choose Properties.
Click on the Auto Play tab.
In the drop down box you can choose the action for each choice shown in the drop
down box.
or Go to Start > Run > type gpedit.msc
Go to Computer Config > Administrative Template > System.
Double-click Turn off Autoplay.
Enable it.

Increase BROADBAND
This is for broad band connections, though it might work for dial up.

•
•
•
•
•
•
•
•
•

Make sure your logged on as actually "Administrator".
Start->Run->type gpedit.msc
Expand the "Local Computer Policy" branch.
Expand the "Administrative Templates" branch.
Expand the "Network Branch".
Highlight the "QoS Packet Scheduler" in left window.
In right window double-click the "Limit Reservable Bandwidth" setting.
On setting tab check the "Enabled" item.
Where it says "Bandwidth limit %" change it to read 0.

Effect is immediate on some systems, some need to re-boot. This is more of a "counter
what XP does" thing. In other words, programs can request up to 20% of the bandwidth be
reserved for them, even with QoS disabled.

Increase Your Cable Modem or DSL Speed in XP
This tweak is for broad band cable connections on stand alone machines with WinXP
professional version - might work on Home version also. It may also work with networked
machines as well.
This tweak assumes that you have let WinXP create a connection on install for your cable
modem/NIC combination and that your connection has tcp/ip - QoS - file and print sharing
- and client for Microsoft networks , only, installed. It also assumes that WinXP will detect
your NIC and has in-box drivers for it. If it doesn't do not try this.
•

•
•

•
•

•
•

In the "My Network Places" properties (right-click on the desktop icon and choose
properties), highlight the connection
then at the menu bar choose "Advanced" then "Advanced Settings". Uncheck the
two boxes in the lower half for the
bindings for File and Printer sharing and Client for MS networks. Click OK.
From the Windows XP CD in the support directory from the support cab, extract
the file netcap.exe and place it in a
directory on your hard drive or even in the root of your C:\ drive.
Next, open up a command prompt window and change directories to where you
put netcap.exe. then type "netcap/?".
It will list some commands that are available for netcap and a netmon driver will be
installed. At the bottom you will
see your adapters. You should see two of them if using a 3Com card. One will be
for LAN and the other will be for
WAN something or other.
Next type "netcap/Remove". This will remove the netmon driver.
Open up Control Panel->System->Dev Man and look at your network adapters. You
should now see two of them and one will have a yellow ! on it. Right-click on the
one without the yellow ! and choose uninstall. YES! You are uninstalling your
network adapter, continue with the uninstall. Do not restart yet.
Check your connection properties to make sure that no connection exists. If you
get a wizard just cancel out of it.
Now re-start the machine.
After re-start go to your connection properties again and you should have a new
connection called "Local area connection 2". Highlight the connection, then at the
menu bar choose "Advanced" then "Advanced Settings". Uncheck the two boxes
in the lower half for the bindings for File and Printer sharing and Client for MS
networks. Click OK.

•
•

Choose connection properties and uncheck the "QOS" box.
Re-start the machine.

After restart enjoy the increased responsiveness of IE, faster page loading, and a
connection speed boost. Why it works, it seems that windows XP, in its zeal to make sure
every base is covered installs two separate versions of the NIC card. One you do not
normally see in any properties. Remember the "netcap/?" command above showing two
different adapters? The LAN one is the one you see. The invisible one loads everything
down and its like your running two separate cards together, sharing a connection among
two cards, this method breaks this "bond" and allows the NIC to run un-hindered.

Use a Shortcut to Local Area Network Connection
Information
Something new in Windows XP, instead of using the command line program and typing
ipconfig to find local area network information, you can use the following shortcut:
•
•
•

Click Start, point to Connect to, and then click Show All Connections.
Right–click the connection you want information about, and then click Status.
In the Connection Properties dialog box, click the Support tab. For even more
information, click the Advanced tab.

To automatically enable the status monitor each time the connection is active, in the
Connection Properties dialog box, select the Show icon in taskbar notification area when
connected check box.

Change the Start Menu Style
Does the new Windows XP Start menu take up too much space on your desktop? You can
easily change the look back to the Windows Classic Start menu by following these steps:
•
•
•

Right–click the Start button, and then click Properties.
Click Classic Start menu.
Click the Customize button to select items to display on the Start menu.

By default, selecting the Classic Start menu also adds the My Documents, My Computer,
My Network Places, and Internet Explorer icons to your desktop.

Add a Map Drive Button to the Toolbar
Do you want to quickly map a drive, but can’t find the toolbar button? If you map drives
often, use one of these options to add a Map Drive button to the folder toolbar.
Option One (Long Term Fix):
•
•

Click Start, click My Computer, right-click the toolbar, then unlock the toolbars, if
necessary.
Right-click the toolbar again, and then click Customize.

•
•

Under Available toolbar buttons, locate Map Drive, and drag it into the position you
want on the right under Current toolbar buttons.
Click Close, click OK, and then click OK again.

You now have drive mapping buttons on your toolbar, so you can map drives from any
folder window. To unmap drives, follow the above procedure, selecting Disconnect under
Available toolbar buttons. To quickly map a drive, try this option:
Option Two (Quick Fix):
•
•

Click Start, and right-click My Computer.
Click Map Network Drive.

If you place your My Computer icon directly on the desktop, you can make this move in
only two clicks!

Do Not Highlight Newly Installed Programs
Tired of that annoying little window that pops up to tell you that new software is installed?
If it gets in the way when you’re logging off, turn it off completely.
To do this:
•
•
•
•

Click Start, right-click at the top of the Start menu where your name is displayed,
and then click Properties.
In the Taskbar and Start Menu Properties dialog box, on the Start Menu tab, click
Customize.
Click the Advanced tab, and then clear the Highlight newly installed programs
check box.
Click OK, and then click OK again.

Now that message won’t be popping up when you least want to see it.

Display Your Quick Launch Toolbar
•
•
•

Right-click an empty area on the taskbar, click Toolbars, and then click Quick
Launch.
Easy as that your Quick Launch bar appears.
To add items to your Quick Launch toolbar, click the icon for the program you
want to add, and drag it to the Quick Launch portion of the taskbar.

Keep Your Favorite Programs Near the Top of the
Start Menu
Do you have a favorite program that you frequently use? Elevate its priority on the Start
menu by putting it at the top of the list. This ensures that the program will remain on the
Start menu and cannot be bumped by other programs, even if you use the others more
frequently.

•

Right-click the link to your favorite program on the Start menu and select Pin to
Start Menu. Your program will be moved permanently to the top part of the list, just
below your browser and e-mail programs.

Stop Password Expiration
After you have run Windows XP for a while, you may receive this message when you log
on: "Your password will expire in 14 days.....". By default, Windows XP is set up with
passwords which will expire after 42 days. And 14 days in advance, Windows will start
warning you of this fact.
•
•
•
•
•
•
•

Go to Start > Run > type control userpasswords2
Select the Advanced tab in the User Accounts window.
Press the Advanced button below the Advanced user management header.
Select Users in the Local Users and Groups.
In the right pane, right-click the user name for which you want to change the
setting, and select Properties.
On the General tab, check Password never expires.
Click Apply and OK (all the way out).

Display Hibernate Option on the Shut Down dialog
For some reason, Hibernate isn't available from the default Shut Down dialog. But you can
enable it simply enough, by holding down the shift-key while the dialog is visible. Now you
see it, now you don't!

My Computer Won't Shut Down Itself After
Installing XP
There are a number of users who have been complaining that their PC will no longer
automatically power down/shut off without pressing the power off button on the
computers unlike in Windows Me/95/2000. There could be a number of reasons for this,
but the main one seems to be that ACPI is not enabled on the computer or in Windows XP:
•
•

Click Start > Control Panel > Performance and Maintenance > Power Options tab.
Then click APM > Enable Advanced Power Management Support.

Create a Password Reset Disk
Microsoft has enhanced security features in XP including the ability to create a floppy
diskette to recover your password in case it is forgotten.
•
•
•
•
•

Click Start > Control Panel > User Accounts.
Click on the account which you want to create a password disk.
Click Prevent a forgotten password which starts the Forgotten Password Wizard .
This is found under Related Tasks.
Insert a blank, formatted disk into drive A, and click Next.
Enter the password in the Current user account password box.

To use the recovery disk, at the Welcome screen:
•
•
•

Click the user name whose password is on the recovery disk.
Click the question mark button, this causes the "Did you forget your password
message" to appear.
Click use your password reset disk. This will start the Password Reset Wizard.

From this point, just follow the wizard's instructions and you will be able to set a new
password.

Modify Settings to Improve Performance
Windows XP uses processor time to handle system performance according to default
settings, which can be adjusted for your computing needs. Also, settings that govern
visual effects enhance the appearance of the Windows XP interface, but can slow down
performance. You can fine–tune settings in Windows XP Professional to improve
performance:
•
•
•
•

Right–click My Computer, and then click Properties.
Click the Advanced tab, and in the Performance area, click Settings.
On the Visual Effects tab, click the Custom radio button, and then select which UI
features to disable to improve performance.
Click the Advanced tab, and in the Processor scheduling area, click the
Background services radio button. Selecting this option means that background
tasks that you want to run while you work, such as backup utilities or print jobs,
will share processor time equally with programs.

You may need to be logged on as an Administrator to make these changes. Note that
applying these settings may change your current desktop theme.

Roll Back to the Previous Version of a Driver
Have you ever installed a device driver that makes your system unstable? Well, in
Windows XP you can roll back such a change if it causes you problems! To go back to the
previous driver for a device:
•
•
•
•

Click Start > Control Panel > Performance and Maintenance > Administrative Tools.
Double–click Computer Management, and then click Device Manager in the left
pane.
Right–click the device for which you'd like to roll back the drivers, and then click
Properties.
On Driver tab of the Properties dialog box, click Roll Back Driver, and follow the
wizard's instructions.

It's that simple, although you need to be an administrator or a member of the
Administrators group to complete this procedure.

Create a Personal Screen Saver

For a great way to put your digital photos to work, try creating a slide show presentation
for use as a screen saver.
•
•
•
•

Right–click an empty spot on your desktop, and then click Properties.
Click the Screen Saver tab.
In the Screen saver list, click My Pictures Slideshow.
Click Settings to make any adjustments, such as how often the pictures should
change, what size they should be, and whether you’ll use transition effects
between pictures, and then click OK.

Now your screen saver is a random display of the pictures taken from your My Pictures
folder.

Disable Automatic Windows Update
Windows XP is configured out of the box to routinely scan for and download updates to
Windows XP automatically. While this can be somewhat convenient for those with very
fast Internet connections and those who would otherwise forget to check for updates, it
can be a nuisance for the rest of us, who are still using 56k or, even worse 33k modem
connections.
•
•

Open the System icon in Control Panel (or right-click My Computer and select
Properties), and choose the Automatic Updating tab.
To check for updates manually, open Internet Explorer and select Windows Update
from the Tools menu.

How to Perform Disk Error Checking in Windows
XP
This article describes how to check the integrity of the hard disk drive in Windows XP.
After you install Windows XP, the Scandisk command is not available.
•
•
•
•

Double-click My Computer, and then right-click the hard disk drive that you want to
check.
Click Properties, and then click Tools.
Under Error-checking, click Check Now.
Click Start.

Creating a Boot Disk for an NTFS or FAT Partition
This article describes how to create a Windows boot disk to access a drive with a faulty
boot sequence on an Intel x86-processor-based computer.
This Windows boot disk can access a drive that has the Windows NT file system (NTFS) or
File allocation table (FAT) file system installed. The procedures in this article can be useful
to work around the following boot problems:
•
•
•

Corrupted boot sector.
Corrupted master boot record (MBR).
Virus infections.

•
•

Missing or corrupt NTLDR or Ntdetect.com.
Incorrect Ntbootdd.sys driver.

This boot disk can also be used to boot from the shadow of a broken mirror, although you
may need to change the Boot.ini file to do that. This Windows boot disk cannot be used for
the following problems:
•
•

Incorrect or corrupt device drivers that have been installed into the Windows
System directory.
Boot problems that occur after the OSLOADER screen.

To work around or fix these problems, run the Emergency Repair disk, load the last known
good control set, or reinstall Windows, if necessary.
The Windows floppy disk must include the files NTLDR, Ntdetect.com, Boot.ini, and the
correct device driver for your hard drive.
Note: The NTLDR, Ntdetect.com, and Boot.ini files usually have their file attributes set to
System, Hidden, and Read-Only. You do not need to reset these attributes for this disk to
work properly.

Method 1: You Do Not Have Access to a Computer Running Windows
•
•
•
•

Create a copy of the first Windows Setup disk using the diskcopy command, and
then delete all files on the new disk.
Copy the Ntdetect.com and NTLDR files from the i386 folder on the CD-ROM to the
new disk.
Rename the NTLDR file to "Setupldr.bin".
Create a Boot.ini file. The following example works for a single partition SCSI drive
with Windows installed under \WINNT; however, the exact value in the [operating
systems] section depends upon the configuration of the Windows System you
want to boot:

[boot loader]
timeout=30
Default= scsi(0)disk(0)rdisk(0)partition(1)\winnt
[operating systems]
scsi(0)disk(0)rdisk(0)partition(1)\winnt="Windows NT"
•

•

If your computer boots from an IDE, EIDE, or ESDI hard drive or a SCSI adapter
that does not have a built in BIOS, replace the scsi(0) with multi(0).
If you are using scsi(x) in the Boot.ini file, copy the correct device driver for the
SCSI controller in use on the computer, and then rename it to Ntbootdd.sys. If you
are using multi(x) in the Boot.ini, you do not need to do this.
Start your computer using the floppy disk, and then log on to Windows.

Method 2: You Have Access to a Computer Running Windows
•
•

Format a floppy disk using the Windows format utility.
Copy NTLDR from the Windows Setup CD-ROM, Windows Setup floppy disk, or
from a computer running the same version of Windows as the computer you want

to access with the boot floppy. You may need to expand this file from NTLDR._ to
NTLDR by using the following command line:

1. expand ntldr._ ntldr
•
•

Copy the Ntdetect.com file to the disk.
Create a Boot.ini file or copy one from a running Windows computer, and then
modify it to match the computer you are trying to access. The following example
works for a single partition SCSI drive with Windows installed under \WINNT;
however, the exact value in the [operating systems] section depends upon the
configuration of the Windows computer you are trying to access:

[boot loader]
timeout=30
Default= scsi(0)disk(0)rdisk(0)partition(1)\winnt
[operating systems]
scsi(0)disk(0)rdisk(0)partition(1)\winnt="Windows NT"
•
•
•

If your computer starts from an IDE, EIDE, or ESDI hard drive, replace the scsi(0)
with multi(0).
If you are using scsi(x) in the Boot.ini, copy the correct device driver for the SCSI
controller in use on the computer, and then rename it to Ntbootdd.sys. If you are
using multi(x) in the Boot.ini, you do not need to do this.
Start using the floppy disk, and then log on to Windows.

Troubleshooting
You may encounter one or more of the following problems when you attempt to start your
computer using your Windows boot floppy disk:
If the path pointing to the system files is incorrect or includes the drive letter, you may
receive the following error message:
Windows could not start because of the following ARC firmware boot
configuration problem: Did not properly generate ARC name for HAL and
system paths. Please check the Windows (TM) documentation about ARC
configuration options and your hardware reference manuals for additional
information. Boot Failed.
If an incorrect SCSI driver has been selected or the Ntbootdd.sys file does not exist, you
may receive the following message: Windows could not start because of a computer disk
hardware configuration problem. Could not read from selected boot disk. Check boot path
and disk hardware. Please check the Windows (TM) documentation about hardware disk
configuration and your hardware disk configuration and your hardware reference manuals
for additional information. Boot Failed.

Change the Logon Window and the Shutdown
Preferences in Windows XP
Setup configures Windows XP to use the friendly Welcome logon screen and the
shutdown buttons, if your computer is installed as a home computer (a computer where a
network domain has not been specified).

This article describes how you can enable the classic logon screen used by Windows XP
Server that resembles the following example:

Log On to Windows
User name: _____________
Password: _____________
To temporarily use the classic logon screen, press Ctrl+Alt+Del twice on the Welcome
logon screen.
To configure Windows XP to use the classic logon and shutdown screens for every logon
session, do the following:
•
•
•
•

Click Start, and then click Control Panel.
Double-click User Accounts.
Click Change the way users log on or off.
Click to clear the Use the Welcome screen check box.

Note: If you disable the Welcome logon screen, you also disable the Fast User Switching
option.

Hard Disk Performance Is Slower Than You
Expect
Symptoms
After you install Microsoft Windows XP, hard disk performance may be slower than you
expect.
Note: Hard disk performance may be even slower when your computer performs many
small hard disk read/write operations.

Cause
This behavior may occur in the following situation:
You use Small Computer System Interface (SCSI) hard disks in the computer.
-andThe hard disks are formatted as NTFS. Resolution
A supported fix is now available from Microsoft, but it is only intended to correct the
problem described in this article and should be applied only to systems experiencing this
specific problem. This fix may receive additional testing at a later time, to further ensure
product quality. Therefore, if you are not severely affected by this problem, Microsoft
recommends that you wait for the next Windows XP service pack that contains this fix.
To resolve this problem immediately, contact Microsoft Product Support Services to
obtain the fix. For a complete list of Microsoft Product Support Services phone numbers
and information about support costs, please go to the following address on the World
Wide Web:
http://support.microsoft.com/default.aspx?scid=fh;EN-US;CNTACTMS

Note: In special cases, charges that are normally incurred for support calls may be
canceled, if a Microsoft Support Professional determines that a specific update will
resolve your problem. Normal support costs will apply to additional support questions and
issues that do not qualify for the specific update in question.

Compress Files and Folders in Windows XP
Running out of room on your hard disk? Need some extra space to install a new program?
Don't worry, Windows XP comes to the rescue. Both Windows XP Professional and Home
Edition now include a zip compression utility that you can use to compress files and
folders on your hard disk.
•
•
•

Right–click the file or folder.
Point to Send To.
Then click Compressed (zipped) Folder.

This will make a compressed folder, identified by a zipper icon, which displays the same
name as the file you compressed. You can also make a compressed folder from scratch,
by following these steps:
•
•
•

Right–click the Desktop.
Point to New.
Click Compressed (zipped) Folder.

Enable Services to Work Through Internet
Connection Firewall
When people are having trouble getting to specific programs or services on your Windows
XP machine after you enable Internet Connection Firewall (ICF), you may need to enable
the program or service to work through the firewall.
•
•
•
•

Click Control Panel > Network and Internet Connections > Network Connections.
Right-click your Internet connection, and then click Properties.
Click the Advanced tab in the Properties dialog box.
Click Settings, and the Advanced Settings dialog box opens.

From there you can enable most common services just by clicking them, or add your own
by clicking the Add button.

Getting an Older Program to Run on Windows XP
If an older application gives you trouble when running Windows XP, you can set the
compatibility properties manually so that the program runs in a different mode, such as
Windows 95, or in a different display or resolution setting.
•
•
•

Right–click the executable or the program shortcut to the executable, and then
click Properties.
Select the Run this program in compatibility mode check box.
From the list, select an operating system that the program runs in comfortably.

•

If necessary, also change the display settings and/or resolution, or disable the
Windows XP visual themes.

Run the program again when you’re finished changing the settings. Adjust the
compatibility settings again if the program is still not running smoothly: a program that’s
unhappy on Windows 2000 may flourish on Windows 98.

Fix Movie Interference in AVI Files
If you have any AVI files that you saved in Windows 9x, which have interference when
opened in Windows XP, there is an easy fix to get rid of the interference:
•
•
•
•

Open Windows Movie Maker.
Click View and then click Options.
Click in the box to remove the check mark beside Automatically create clips.
Now, import the movie file that has interference and drag it onto the timeline. Then
save the movie, and during the rerendering, the interference will be removed.

One-Click Shutdown
If you have Clean Sweep Deluxe, you should disable it before proceeding. Follow these
directions to create a one-click shutdown shortcut:
•
•
•
•
•
•

Navigate to your Desktop.
On the Desktop, right-click and go to New, then to Shortcut (in other words, create
a new shortcut).
You should now see a pop-up window instructing you to enter a command line
path.
Enter one of these as the path: SHUTDOWN -s -t 01
If the C: drive is not your local hard drive, then replace "C" with the correct letter of
the hard drive.
Click the "Next" button.
Name the shortcut and click the "Finish" button.

Now whenever you want to shut down, just click on this shortcut and you're done. Also, if
you want to make life better and faster, you can right-click the new shortcut you just made,
go to Properties, and type in X (or whatever letter) in the Shortcut Key box.

Move the Paging File in Windows XP
This article describes how to change the location of the paging file in Windows XP.
The paging file is the area on the hard disk that Windows uses as if it were random access
memory (RAM) This is sometimes known as "virtual memory." By default, Windows stores
this file on the same partition as the Windows system files. You can increase the
performance of Windows, and increase free space on the boot partition, by moving this file
to a different partition.
•
•

Log on to the computer as Administrator.
Click Start, and then click Control Panel.

•
•
•
•
•

•
•

Click Performance and Maintenance, and then click System.
Click the Advanced tab, and then under Performance, click Settings.
Click the Advanced tab, and then under Virtual memory, click Change.
In the Drive [Volume Label] list, click a drive other than the one on which Windows
is installed (Windows is usually installed on the drive C). Under Total paging file
size for all drives, note the value that is displayed next to Recommended.
Click Custom size, and then type the recommended value in the Initial size (MB)
box.
Type the maximum size that you want to allow for paging in the Maximum size
(MB) box, and then click Set.
In the Drive [Volume Label] box, click the drive on which Windows is installed
(usually the drive C), and then use one of the following steps:
If you do not want a paging file on the drive, click No paging file, and then click
Set. A message similar to the following message appears:
If the pagefile on volume C: has an initial size of less than 126 megabytes,
then the system may not be able to create a debugging information file if a
STOP error occurs.
Continue anyway?

•
•

Click Yes.
If you want to keep the minimum size of the paging file on the drive, click Custom
size, and then type a value that is equal to or greater than the amount of RAM in
the computer in the Initial size (MB) box. Type that same value in the Maximum size
(MB) box, and then click Set.
The following message appears:
The changes you have made require you to restart your computer before
they can take effect.

•
•

Click OK, click OK, click OK.
Then click Yes when you are prompted to restart the computer.

Disable Error Reporting
You can get rid of the Windows XP error report messages if you don't want to send
another one in.
•
•
•
•
•

Click Start, and then click Run.
Type msconfig to open the System Configuration Utility.
Click the Services tab.
Clear the Error Reporting Service check box, and then click OK.
Hit Restart to reboot your system.

Your computer will now start without loading the error reporting service.

Use Backup to Back Up Files and Folders on Your
Computer in Windows XP

This article describes how to use Backup Utility for Windows (included with Windows XP)
to back up files and folders on your computer.
The Backup tool in Windows XP helps you protect your data in case your hard disk fails or
files are accidentally erased. By using Backup, you can create a duplicate copy of all of
the data on your hard disk and then archive it on another storage device, such as a hard
disk or a tape.
If the original data on your hard disk is accidentally erased or overwritten, or becomes
inaccessible because of a hard-disk malfunction, you can easily restore the data from the
disk or archived copy by using the Restore Wizard or Automated System Recovery
Wizard.
Note: You must have permissions as an administrator or a backup operator on your
computer to back up files and folders. Also, backup operators and administrators can
back up and restore encrypted files and folders without decrypting the files or folders.
•
•
•
•
•
•

•
•
•
•

•
•
•
•
•

Click Start > All Programs > Accessories > System Tools > Backup. The Backup or
Restore Wizard starts.
Click Advanced Mode.
Click the Backup tab.
On the Job menu, click New.
Select the check boxes for the drives that you want to back up. If you want to be
more specific in your selections, expand the drive that you want, and then click the
check boxes for the files or folders that you want.
Select the System State check box.
Note: If you want to back up your system settings as well as your data files, you
should back up all the data on your computer plus the System State data, which
includes such things as the registry, the COM+ class registration database, files
under Windows File Protection, and boot files.
In the Backup destination list, click the backup destination that you want to use.
If you clicked File in the previous step, type the full path and file name that you
want in the Backup media or file name box. Note that you can also specify a
network share as a destination for the backup file.
Click Start Backup. The Backup Job Information dialog box appears.
Under If the media already contains backups, use one of the following steps:
If you want to append this backup to previous backups, click Append this backup
to the media.
If you want to overwrite previous backups with this backup, click Replace the data
on the media with this backup.
Click Advanced.
Select the Verify data after backup check box.
In the Backup Type box, click the type of backup that you want. When you click a
backup type, a description of that backup type is displayed under "Description."
Click OK, and then click Start Backup. A Backup Progress dialog box appears, and
the backup starts.
When the backup is complete, click Close.

Use Backup to Restore Files and Folders on Your
Computer in Windows XP
This article is a step-by-step guide to using the Backup program in Windows XP to restore

files and folders on your computer.
The Backup utility in Windows XP helps you protect your data in case your hard disk fails
or files are accidentally erased. By using Backup, you can create a duplicate copy of all of
the data on your hard disk and then archive it on another storage device, such as a hard
disk or a tape.
If the original data on your hard disk is accidentally erased or overwritten, or becomes
inaccessible because of a hard-disk malfunction, you can easily restore it from the disk or
archived copy by using the Restore Wizard or Automated System Recovery Wizard.
Note: You must have permissions as an administrator or a backup operator on your
computer to restore files and folders. Also, backup operators and administrators can back
up and restore encrypted files and folders without decrypting the files or folders.
•
•
•

Click Start > All Programs > Accessories > System Tools > Backup. The Backup or
Restore Wizard starts.
Click Advanced Mode.
Click the Restore and Manage Media tab.

If you want to restore from a backup file:
•

Expand File, and then expand the backup file that you want. For example, expand
Backup.bkf created 01/01/2002 at 1:15 PM. Backup includes the date and time of
the backup as part of the file name by default.

If you want to restore from a tape backup:
•

Expand the tape device that you want (for example, Travan), and then expand the
media name that you want. For example, expand Media created 01/01/2002 1:15 PM.

Select the check boxes for the folders that you want to restore. If you want to be more
specific in your selections, double-click the folder that you want, and then select the check
boxes for the files or folders that you want to restore.
If you are restoring the entire operating system, select the System State check box.
Note: If you want to restore the operating system as well as your data files, you should
restore the System State data, which includes such things as the registry, the COM+ class
registration database, files under Windows File Protection, and boot files.
In the Restore files to box, use one of the following steps:
•
•

Click Original location if you want to restore the files to the location from which
you backed them up. Use this selection when you restore the entire computer.
Click Alternate location if you want to restore a file or files to another location on
the hard disk. Type the location that you want in the Alternate location box. Use
this selection to prevent the restore operation from overwriting existing files on
your computer.

•

•
•

Click Single folder if you want to restore a file or files to a single folder on the hard
disk. Type the location that you want in the Alternate location box. Use this
selection to separate the restored files or folders from the rest of the files on the
hard disk.
On the Tools menu, click Options.
Click the method that you want Backup to use when it restores a file that is already
on the computer, and then click OK. Backup uses this selection to determine
whether to overwrite an existing file only when it restores a file in a folder that
contains the existing file.

•
•

Note: If you are restoring the operating system, click Always replace the file on my
computer.
Click Start Restore.
If the following message appears, click OK if you want to restore the System State
information with the selected backup:
Warning!
Restoring System State will always overwrite current System State unless
restoring to an alternate location.

•
•
•

In the Confirm Restore prompt that appears, click OK. A Restore Progress dialog
box appears, and the restore operation starts.
When the restore process is complete, click Close.
If you are prompted to restart the computer, click Yes.

Schedule Tasks in Windows XP
With Scheduled Tasks, you can schedule any script, program, or document to run at a
time that is most convenient for you. Scheduled Tasks starts every time that you start
Windows XP and runs in the background, and it starts each task that you schedule at the
time that you specify when you create the task.
To open Scheduled Tasks:
•

Click Start > All Programs > Accessories > System Tools > Scheduled Tasks.

To schedule a new task:
•

Double-click Add Scheduled Task to start the Scheduled Task Wizard, and then
click Next in the first dialog box.

The next dialog box displays a list of programs that are installed on your
computer, either as part of the Windows XP operating system, or as a
result of software installation.
Use one of the following procedures:
If the program that you want to run is listed, click the program, and then
click Next.
If you want to run a program, script, or document that is not listed, click

Browse, click the folder and file that you want to schedule, and then click
Open.
Type a name for the task, and then choose one of the following options:

•

•
•

•

Daily

•

Weekly

•

Monthly

•

One time only

•

When my computer starts (before a user logs on)

•

When I log on (only after the current user logs on)

Click Next, specify the information about the day and time to run the task, and then
click Next.
Note that the information about the day and time to run the task vary depending on
the selection that you made in the previous wizard dialog box. For example, if you
chose Weekly, you must indicate the day of the week, the time, and if the task
should run every week, every 2 weeks, every 3 weeks, and so on.
Type the name and password of the user who is associated with this task. Make
sure that you choose a user with sufficient permissions to run the program. By
default, the wizard selects the name of the user who is currently logged on.
Click Next, and then click Finish after you verify the choices that you have made.

Using Advanced Options in Scheduled Tasks
If you want to change the configuration of the task:
•
•

Click Open in the Advanced properties for the task before you click Finish. After
you click Finish, the Properties dialog box opens for the task.
On the Schedule tab, you can change any of the scheduling options that you chose
in the wizard, and you can also change the task configuration so that the task does
not run too long, does not run if the computer is running on batteries (for laptops),
and to specify whether or not the computer should be idle for the task to run.
Note: You can open the Properties dialog box for the task at any time if you open
Scheduled Tasks, right-click the task, and then click Properties.

•

You cannot schedule a task so that it repeats in an interval less than one day;
however, you can do this in the Properties dialog box:
Click the Schedule tab, and then click Advanced.
Click to select the Repeat task check box, and then specify the number of minutes
or hours in which you want the task to be repeated.

